
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

SmaPri Designer 

Operation Manual 
 

 

 

 

 

 

 

 

 

 

 

 

 

SATO CORPORATION 

Rev.20240605  



 
SmaPri Designer Operation Manual 

 

 

2 

Introduction 

Thank you for purchasing SmaPri. SmaPri is a printing support application for label printing 

that works with various Android / iOS applications using format files created in the label 

design creation tool, a SmaPri Designer with the smartphone development tool SmaPri Driver. 

 

This manual explains the basic operations of SmaPri Designer, object settings, tables, and data 

output. This manual can also be used as the explanation displayed by the help button in the 

product. 

 

Attention 

・ The copyright for this software is held by SATO CORPORATION. 

・ This software and this manual may not be copied or duplicated, whether partially or in their 

entirety, regardless of the form, without the permission of SATO CORPORATION. 

・ This software and this manual may only be used based on the product's license agreement. 

・ SATO CORPORATION bears no responsibility for the results of using this software and this 

manual. 

・ The content of this manual may be corrected or revised without prior notification. 

・ The utmost care has been taken with the content of this manual. However, if you discover 

some problem with the content or something otherwise unusual with the content, please 

contact SATO CORPORATION. 

 

・ SATO and SmaPri are registered trademarks and/or trademarks of SATO HOLDINGS 

CORPORATION. 

・ Other company names and product names listed in this manual are registered trademarks 

and/or trademarks of those respective companies. 
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The 1st chapter: Product Information 

 

 

Product 

information 

The 1st chapter 
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1-1. Required hardware and software 

1-1 
Required hardware and software 

- Hardware - Software 

 

The following hardware and software are required to use SmaPri Designer. 

 

- Execution environment 

Compatible OS (32-bit)  Windows 11, Windows 10 

Compatible OS (64-bit) * Windows 11, Windows 10 

  *It runs as a 32-bit application on 64-bit OS. 

 

CPU Pentium compatible CPU 1GHz or faster recommended 

Memory 1024 MB or more recommended 

Hard disk 300 MB or more free space 

Screen resolution** XGA (1024x768) or higher 

 **SXGA (1280x1024) or higher recommended 

 

  *Due to USB license key restrictions, use in virtual environments or remote desktops is not 

supported. 

 

- Printer 

Class Model 

Mobile printer PW4NX, PW208/PW208NX series, PT408e/PT412e 

Desktop printer SCeaTa CT4-LX, L'esprit HC4-LX, FX3-LX Plus, FX3-LX, CL4NX-J 

Plus series, CL6NX-J Plus series, CL4NX-J series, CL6NX-J series, 

EV200R series, HA200R series, L'esprit V-ex series, RT308R, 

ST300R series 

International 

model 

PW4NX, PW208NX, MB400i/MB410i, CT4-LX, CL4NX Plus, CL6NX 

Plus, CL4NX, CL6NX, CG208/212/408/412, TG308/TG312, DR308e 
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1-2. About SmaPri Designer 

1-2 
About SmaPri Designer 

- Product overview 

 

- Product overview 

SmaPri Designer is a label design creation application that runs on a PC. 

It creates the format file (*.spfmtz) that SmaPri Driver uses when printing labels. 

 

SmaPri Designer and SmaPri Driver relationship diagram 

 

 

 

 

 

 

Developer 

Operator 

Dev. Design 

Format file 

・Native application 

・Web application 

Print data 

Application Development Environment 

 (HTML5, Xcode, Android Studio, etc.)  

Load Print 

Output 
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1-3. Install / Uninstall 

1-3 
Install / Uninstall 

- Install  - tax rate setting  - Uninstall 

 

To install SmaPri Designer, log in as a user with Administrator privileges. 

If an older version of the software is already installed, the new version can be installed over it. 

- Install 

1) Run the SmaPri Designer setup file. 

  

2) User Account Control (UAC) is displayed. Select either "Allow" or "Yes" according to the 

dialog. 

 

 

3) The installer starts and checks the execution environment. 

If .NET Framework 4.5 is not installed, the Microsoft installer starts automatically. 

Follow the on-screen directions to install the software. 

 

4) When the setup wizard is displayed, click "Next". 
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5) Please make sure to read through the license agreement as it states important terms 

and condition for the use of the product. 

 

 

6) Click "Next". (Select "Browse", you can change the installation folder.) 

 

 

7) Click "Next". 
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8) The setup wizard installs the software. 

 

 

9) Click "Close". 

 

 

10) Connect the USB key (HASP) to a USB port. 

 

 

 

11) Installation of SmaPri Designer has completed. The program icon appears on the 

desktop. 

 

  

SmaPri
000001

Note: Connecting the USB key (HASP) 
If you accidentally connect the USB key (HASP) before the software finish installing, it will not be 
correctly recognized. If the USB key (HASP) was accidentally connected, please disconnect it and 
reinstall the software. 
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- Tax rate setting when starting for the first time. 

The [Tax rate setting] screen is displayed when SmaPri Designer starts for the first time or a 

SmaPri Project file opens for the first time.  

Change the tax rate if necessary and click [OK] to confirm. 

 

 

 

 

  

notes: 
The tax rate set on this screen is the value used when a new project is created. 
If you need change tax rate to existing Project file, you can use the [tax rate batch change]. 
For details, please refer "5-12. Set the tax rate". 
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- Uninstall 

1) Open the [Control Panel]. 

 

2) Select [Programs and Features].  

 

3) Select "SmaPri Designer" on the installed programs list and click the [Uninstall] or 

[Remove] button. 

 

4) A confirmation message is displayed. Select [Yes] to uninstall. 
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1-4. Tool display language 

1-4 
Tool display language 

- Option settings  

 

SmaPri Designer language is displayed in the following languages as it depend the installed 

operating system language. 

  

Operating system language is Japanese: Displayed in Japanese 

Operating system language is not Japanese: Displayed in English 

 

- Change the language 

1. On the menu bar, select [Tool] > [Settings]. 

 

2. Select [Language] with the language tab.  
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The 2nd chapter: Basic Operation 

 

 

Basic 

Operation 

  

The 2nd 

chapter 
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2-1. Display of the buttons 

2-1 
Display of the buttons 

- select/unselect 

 

Many kinds of actions are performed when you click the buttons on the SmaPri Designer 

window. 

The selection state of the buttons in SmaPri Designer is shown below. 

(The background color and the selection color may differ according to the settings of the 

operating system of the PC being used.) 

 

- Object bar selected state/unselected state 

 

 

Selected state Unselected state 

 

 

 

 
 

 

 

      

 

 

- Toolbar selected state/unselected state 

 Selected button Unselected button 

 

 

  

 

 

 

 

- Data window selected state/unselected state 

 Selected button Unselected button 
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2-2. Mouse cursor 

2-2 
Mouse cursor 

- select/change  

 

The shape of the mouse cursor displayed in SmaPri Designer changes according to the 

operation that can be performed at that time.  

* The mouse cursor shapes may differ according to the PC settings. 

 

Normal cursor : The normal cursor. 

Cursor when pasting objects : The state when objects are ready to be pasted. 

Selected object cursor : Moves the position of the pasted object. 

Size modification cursor : Changes the object size. 

 

 

- Selected objects and the selected object cursor 

When an object is selected, a light-pink frame is displayed 

as shown in the figure to the left. 

The selected object cursor can move the position of the 

object by dragging the object. 

 

The object can also be moved by pressing the arrow keys on the keyboard while holding 

down the Ctrl key. 

 

 

- Selected objects and the size modification cursor 

If you move the cursor to the edge of an object, the cursor 

changes to the size of modification. Drag this cursor and you 

can change the size of certain objects like barcodes and 

graphics. 
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2-3. Window configuration 

2-3 
Window configuration 

- Window configuration  

 

The SmaPri Designer window has the following window configuration. 

The screen configuration can be modified by showing or hiding items and by moving windows. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Basepoint of object 

The basepoint of selected object is indicated by green square and there are two patterns. 

- Single object (not grouped): Upper-left corner of the object. 

- Grouped objects: Vertical position and horizontal position, respectively the minimum value 

in the group. 

 

Data window: This part 

configures the selected 

object. 

Project window: This part 

displays the levels of 

created data. Right click on 

data and it can be 

manipulated. 
Object bar: Select the object you 

wish to print and click the design 

window to paste that object. 

Design window: This part is for laying out 

the design of the label. (Switch display with 

input screen design window) 

 

Multiple overlapping design windows can 

be displayed. Up to 30 windows can be 

opened at one time, but if many windows 

are opened simultaneously, the operation of 

the PC may slow down. 

Switch 

Sheet rotation: Rotate 

the paper 0 degree / 90 

degree /180 degree / 

270 degree. 

Input screen design window: This part configures the input 

screen order settings displayed on the smartphone. 

(Switch display with design window) 

Toolbar: Often used functions included in the 

menu bar that have been turned into icons. 

Menu bar: This part displays the menus that can be 

used with the active window. 
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2-4. Toolbar 

2-4 
Toolbar 

- Toolbar  

 

You can use the operations below by clicking the buttons on the toolbar. 

Button Function name Function 

 
New Creates a new file. 

 
Save project Saves the project file 

 
Import sample Accesses the sample folder and imports a file 

 
Add file Imports a tool related file 

 
Preview test print Print preview check and label print instruction window. 

 
Data output Writes the created data to the specified output destination 

 
Undo Undoes the operation (10 max) 

 
Redo Restores the operation (when [Undo] is used, 10 max) 

 
Cut Cuts the selection 

 
Copy Copies the selection 

 
Paste Pastes the selection 

 
Show help Displays the help 

 

Horizontal 

position 

Specifies the horizontal position of the selected object 

After entering a numeric value, press the Enter key to confirm 

 

Vertical 

position 

Specifies the vertical position of the selected object 

After entering a numeric value, press the Enter key to confirm 

 
Align left Aligns multiple selected objects to the left 

 
Align right Aligns multiple selected objects to the right 

 
Align horizontal center Horizontally aligns multiple selected objects to the center 

 
Align even horizontal Aligns the horizontal position of multiple selected objects to be even 

 
Align top Aligns multiple selected objects to the top 

 
Align bottom Aligns multiple selected objects to the bottom 

 
Align vertical center Vertically aligns multiple selected objects to the center 

 
Align even vertical Aligns the vertical position of multiple selected objects to be even 

 
Rotate Rotates the selected object 

 
Zoom in Zooms in the window display 

 
Zoom out Zooms out the window display 

 
Normal Switches the normal display size 

 
Align with screen Fits the display size to the screen 
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2-5. Design window 

2-5 
Design window 

- Design window 

 

On the design window, you can paste objects and change their size. 

You can check the status of items by their color and how they are displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Blue text: 

Items to input when printing. 

Data: 

Items set with fixed data or initial 

data. 

(Item name): Items to input when printing that are 

not set with initial data. The frame size is an area of 

the number of digits configured by [Digits]. 

Black text: 

Fixed data items. 

Gray: 

Items not printed. 

Red text: 

Items in the error state. 

Place the cursor over the item when selected 

to display error details. 
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2-6. Input screen settings 

2-6 
Input screen settings 

- Input screen settings 

 

You can change the settings for the input order when printing. 

  

 

Setting items Contents 

Move up Moves one selected row up in the list. 

Move lower Moves one selected row down in the list. 

Setting screen 

Name 
Shows the item name of "Key input (data)" objects pasted 

on the layout screen. 

Type 
Shows the type of "Key input (data)" objects pasted on the 

layout screen. 
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2-7. Obuject bar 

2-7 
Object bar 

- Object bar 

 

Paste the objects listed below on the design window to create the layout. 

 

 

 

 

 

 

 

Objects Contents 

Select Selects objects on the design window. 

String Pastes a string object. 

Price 
Pastes a price object. 

The tax rate and discount rate can be configured. 

Barcode Pastes a barcode object. 

Date time Pastes a date and time object. 

Counter Pastes a counter object. 

Fixed graphic Pastes a fixed graphic object. 

Switching 

graphic 
Pastes a switching graphic object. 

Line Pastes a line object. 

Frame  Pastes a frame object. 

Table Pastes a table object. 

Command Pastes a command object. 
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2-8. Project window  

2-8 
Project window 

- Project window 

 

The project window is the part that displays and manipulates the list of files in the project. 

 

 

The types of files below can be displayed and manipulated. 

Type Menu Details 

Project 

New group Creates a new print layout group 

New print layout Creates a new print layout 

New table Creates a new table 

Graphic table Creates a new graphic table 

New graphic Creates a new graphic 

Project settings Project operations 

Print layout folder 
New group Creates a new print layout group 

Paste *1 Pastes a print layout group 

Print layout group 

 

New print layout Creates a new print layout 

Cut Cuts a print layout group 

Copy Copies a print layout group 

Paste *1 Pastes a cut or copied print layout 

Delete Deletes a print layout group 

Print layout 

Open Opens the print layout editing window 

Cut Cuts a print layout 

Copy Copies a print layout 

Delete Deletes a print layout 

Settings Opens the print layout settings window 

Table folder 

New table Creates a new table 

New graphic table Creates a new graphic table 

Paste *1 Pastes a cut or copied table file 

Right click to 

display the menu 
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Table 

Open Opens the table editing window 

Cut Cuts a table 

Copy Copies a table 

Delete Deletes a table 

Graphic table 

Open Opens the graphic table editing window 

Cut Cuts a graphic table 

Copy Copies a graphic table 

Delete Deletes a graphic table 

 

Note 1: When pasting, for example, when copying and pasting a print layout file, it can be 

pasted when the level directly above it is selected, in this case a print layout group. 

 

Switching the display 

The project window can display items by type such as layout and table, in addition to the 

project tree view. 

You can easily check free print layout numbers by displaying items by type. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Sortable by item 
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2-9. Coordinate unit  

2-9 
Coordinate unit 

- Coordinate unit 

 

Choose unit of length from mm / dot / inch. 

As the selected unit is saved in the SmaPri Designer settings, the unit will be used for all files in 

the project. 
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The 3rd chapter: Basic Setup 

 

 

Basic Setup 

The 3rd chapter 
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3-1. Startup of SmaPri Designer 

3-1 
Startup of SmaPri Designer 

- Startup 

 

When starting SmaPri Designer from a shortcut icon and when displaying a created project 

file, the USB type HASP which is your license key must be plugged into the PC to be used and 

recognized. 

 

If the license key is not recognized, the following message is displayed. 

 

 

 

 

Note: The license key 

When use format files (printing files) output when the license key cannot be recognized, a 

warning message will display when printing from SmaPri Driver. 

 

SmaPri Designer will no longer start when the 30-day evaluation period has expired. 

Please purchase a license. 
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3-2. Select the project   

3-2 
Select the project 

- Project 

 

This window is displayed when SmaPri Designer starts. 

Select whether to create a new project or to specify an existing project file. 

 

 

 

Setting items Contents 

New Creates a new file. 

Browse Browses for an existing file. 

Cancel Quits the selection window 
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3-3. Select the printer   

3-3 
Select the printer 

- Select the printer 

 

This window displays the list of printers that are compatible with SmaPri. 

Select the printer to connect to with the smartphone on the printer icon list. 

After selecting the printer, click the [Next] button to go to the next window. 

 

When SmaPri Designer is installed and first started, either the Japanese printer category or 

the international printer category is displayed according to the language of the operating 

system. 

- Operating system language is Japanese -> Displays Japanese printers 

- Operating system language is not Japanese -> Displays international printers 

 

- Select the printer 

1) On the menu bar, select [File] > [Project settings]. 

 

2) The printer can be changed from the printer tab. 

 

 

The printer selected on this window affects the maximum and minimum paper sizes, the font 

and barcode types, and the printer control functions, so always select the printer that will be 

used. 
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3-4. Paper settings    

3-4 
Paper settings 

- Paper settings 

 

Set the type of paper to be used, the sensor type and the paper size. 

Values modified on the layout default settings window become the initial values when creating 

subsequent new layouts. 

 

 

Setting items Contents 

Select the paper to be used Selects the paper to use. 

Sensor type Selects the sensor type to use. 

Paper size Enter the paper size to use. 

Sheets typically used with the configured printer are preregistered on the sheet selection list. 

If you select a sheet size other than free size, those settings are automatically reflected in 

sensor type and sheet size. After selecting these sheets, the sensor type and sheet size can be 

modified. 

 

 

 

 

 

 

 

 

 

  

If Free size (Sensor disable) is selected... 

Sensor type: Continuous (Label size)  

Paper size: Height 50 mm, Width 50 mm 

is automatically reflected in the settings 
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- Advanced 

The advanced settings configure the details of the printer operation. 

Values modified on the layout default settings window become the initial values when 

creating subsequent new layouts. 

 

 

Setting items Contents 

Print speed set 
Move the slider bar by dragging it to specify the print speed for the printer. 

If the check box is not selected, the setting on the printer is valid.  

Print darkness set 
Move the slider bar by dragging it to specify the print darkness for the 

printer. If the check box is not selected, the setting on the printer is valid. 

Label gap Specifies the horizontal and vertical gap size for the label. 

linerless label If the check box is selected, the label gap setting is invalid. 

Print Offset Sets the overall print offset values for the layout. 

Batch marking Configures whether or not to print batch marks. 

Cutter Specifies the cutting method. 

Quantity 
When cutting at the specified quantity is selected, specifies the quantity to 

cut at. 

Cut position Specifies the cut position from the center hole. 

Ejection cut Configures whether or not to perform an ejection cut after printing finishes. 

Direction Specifies the paper ejection direction. 
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- About cutter mode 

The printer will operate as displayed in the diagram below when each cutter operation settings are set. 

Label 『Ejection cut』Checked 『Ejection cut』No Check 

Never 

  

Each cut 

  

Cut the specified quantity 

When printing 5 pieces wit the 

settings that cut the third sheet. 

  

Tag 『Ejection cut』Checked 『Ejection cut』No Check 

Never 

  

Each cut 

  

Cut the specified quantity 

When printing 5 pieces wit the 

settings that cut the third sheet. 

  

cutter 

RT308R The cut position that when printer is used FEED button offline state. 

ST3xxR The cut position that when printer is used ejection cut button. 

 

- Explanation of paper setting terms 

・Label gap 

 

Left/right (horizontal) 

The distance from the edge of the label backing on the label. 

Vt. (vertical) 

The distance from the end of the previous label to the start of 

the next label. 

*Left/right: 1.5 mm, Vt.: 3 mm are SATO's normal values. 
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・Journal paper 

Journal paper is like a receipt paper. 

The sensor type can be selectable from “Receipt paper (Label size)”,” Receipt paper (Print 

end position)”,"Receipt paper(variable length)”  

 

When “Receipt paper (Label size)” is selected, the paper size specified in the layout 

settings will be applied. 

When “Receipt paper (Print end position)” is selected, printing will stop at the end position 

of print objects. 

 

 

“Variable length” is used to print multiple layouts in combination. When “Variable length” is 

used to print single layout, it is printed to layout setting size Similar to the “Label size”.  

 

・Batch marking  

 

  

This feature will apply ink on the side of the tag so tags stacked in 

the stacker can be easily sorted. 

 

The batch mark is applied on the side of the first tag. 

The space that it is possible to put batch marks on is the specified 

quantity and print unit. 

 

  

Batch mark 

The stop position of “Print end position” 

The stop position of “Label size” 
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・Print offset 

Print offset corrects the overall print position. 

When the printed position of the tag deviates from 

the intended position, even if the paper was 

correctly set, you can adjust the print position by 

entering the offset values. 

For vertical, positive values move down, negative 

values move up. 

For horizontal, positive values move to the right, 

negative values move to the left. 

 

 

 

 

 

 

 

  

 

 

 

 

・Cut position (Only when tag is selected) 

The distance between the center point of the tag's center hole and the cut position. 

 

 

 

 

 

 

 

・Ejection cut 

A feature that feeds the printed paper inside the printer and cuts it when printing is 

finished. 
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3-5. Tax and discount rate settings     

3-5 
Tax and discount rate settings 

- Tax and discount rate 

 

This tab sets the calculation method for price items on the layout to either a tax calculation or 

discount calculation. 

On a single layout, either a tax calculation or discount calculation can be configured for the 

calculation setting. 

The values set on this tab are reflected in the initial values when creating new layouts, so you 

can save the work of having to set these values for each layout by setting the standard values 

in advance. 

 

 

Setting items Contents 

Tax 

This item makes it possible to set the tax rate calculation with price 

items on the layout. The following values can be calculated. 

1. With the value that was input as the unit price, the tax inclusive 

price and tax price value can be calculated. 

2. With the value that was input as the tax inclusive price, 

the unit price and tax price value can be calculated. 

[Change tax rate] 

button 

The tax rate value can be modified.  

The tax rate value can only be set as an integer. 

Discount 

This item makes it possible to set the discount rate calculation with 

price items on the layout.With the value that was input as the price 

before discount, the price after discount and the discount amount can 

be calculated。 
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Different than the tax rate, the discount 

rate often has a set value that differs for 

each layout, so it is only displayed on 

the layout default settings window. 

On the layout settings window, not just 

the tax rate, but the discount rate can 

also be changed. 

Note: Setting the right of the decimal point 
If the decimal point of the value has been set in the older version, the following warning message is 
displayed and the decimal point is truncated to integer. 
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3-6. Currency settings     

3-6 
Currency settings 

- Currency settings 

 

This tab is to configure the displayed symbols that include the currency symbol for the price 

items on the layout. The initial value is the currency symbol configured on the PC. 

 

 

 

Setting items Contents 

Currency symbol 
Select from the "¥", "$", and "€" symbols, or you can also enter 

the desired text within 5 characters. 

Decimal separator symbol 
Select from the "." (period) and "," (comma) symbols, or you 

can also enter the desired text within 3 characters. 

Digit separator symbol 

Select from the "." (period), "," (comma), and " " (space) 

symbols, or you can also enter the desired text within 3 

characters. 

Print zero (0) 

When zero value (0) is entered as a price object, it prints with 

currency symbol and "0" if this check box is selected. If the 

check box is not selected, currency symbol and "0" will not be 

printed but it will become blank. 
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The 4th chapter: Data Window Explanation  

 

 

Data Window 

Explanation 

The 4th chapter 
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4-1. File properties     

4-1 
File properties 

- Project - Group - Print layout - Table 

- Project 

This window configures the project information. 

You can configure the settings for the project overall and the initial values when creating a 

new layout. 

 
Setting items Contents 

ProjectName Shows the saved file name as the project name. 

QTY name 

Sets the field name to be used for Print Quantity. 

When the field is left blank, it will display as "Print 

Quantity". 

Set the QTY name to 16 or fewer characters. 

[Project settings] button This button opens the project settings dialog. 

[Layout default settings] button This button opens the layout default settings dialog. 

 

・Project settings dialog 

Modifies the settings for the entire project. 

Printer tab 

Select printer type and create the data layout. 

 

If you change the printer type, the fonts and 

other settings configured for the layouts may 

be changed. 

 

After changing the printer type, always open 

the existing layouts and check their contents. 
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・ Layout default settings dialog 

Sets the initial values when creating new layouts. 

 

 

 

 

Setting items Contents 

[Paper] tab Opens the paper settings tab. 

[Tax and discount 

rates] tab 
Opens the tax and discount rate settings tab. 

[Currency] tab 
Opens the currency symbol, decimal place symbol and separator 

symbol settings tab. 

 

- Group 

This window configures the record data (print layout) group information. 

Group name 

Set Group name. 

 

 

Note: Layout settings 
To modify the settings for existing layouts, configure them individually using "Layout settings". 
The settings in "Layout default settings" are not reflected in the existing layouts. 

Note: Group name 
The group name is used for management in 

SmaPri Designer. It is not reflected when 
printing. 
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- Print layout 

This window configures the print layout information. 

The values set here are reflected in the layout currently being edited. 

Print layouts can be registered up to 200 layouts in a single project. 

 

 

Setting items Contents 

Record name 
Sets the name of the record data (print layout). Sets the 

name to 32 or fewer characters. 

Record No. 
Sets the number of the record data (print layout). 

This number is used when calling the data during printing. 

Embedded TrueType font 

TrueType font can only be used for the string object when 

you set the input method as [key input]  

This function cannot be used with reference/concatenate. 

[Read-only] button Prohibits overwriting the modified contents. 

[Layout settings] button 
Opens the layout settings dialog (paper information, tax and 

discount rate settings). 

 

・ About the TrueType font embedding function 

This function enables you to use Windows fonts for the string object by including the 

Windows fonts selected on SmaPri Designer in the format files. 

 

Notes: Preview and the printed results 
Because of the differences in the Windows operating system that SmaPri Designer runs on and the Android 
operating system of the terminal that will print, the preview and the printed results may differ due to the 
specified font type and input text.Always check the printed results beforehand. 
 
Examples where the preview and the printed results differ 
1. When using the automatic line feed function, the position of the line feed may differ for the preview and 

printed results. 
2. When the input character is not contained in the specified font, a substitute font may be used for printing 

or the character may be corrupted. 
3. When a special font such as a symbol font is used, the preview and printed results may differ. 
Example: When the font type is "Symbol" and "a" is input, the preview shows "α", but the printed result is 

"a". 
 The group name is used for management in SmaPri Designer. It is not reflected when printing. 
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- Table 

This window configures the table information. 

Tables can be registered up to 99 tables in a single project. 

For the table, one data table allows you to register 1,000 entries and one graphic table 

allows you to register 5 entries. 

 

Table name 

Set the table name. 

 

Table No. 

Set the table number. 

* For a graphic table, fixed as table No. 100. 

 



 
SmaPri Designer Operation Manual 

 

 

43 

4-2. Object properties     

4-2 
Object properties 

- String - Price - Barcode - Date time - Counter 

 

- String object 

This window configures the settings for the string object. 

 

Setting items 

Item name 

Sets the item used in the layout design.When the input method is [Key input (data)], this 

can also be displayed as the input item name. 

When no value is set for [Data], "(item name)" is displayed on the design window in blue 

text. The item name can be set up to 16 digits. 

Input method 

Fix Uses the value set for [Data]. 

Key input Uses the value that be input when printing. The value set in [Data] is the initial value. 

Reference / 

Concatenate 

Copies an object, keys in fixed values and uses a value made of multiple object values 

combined.  

[Advanced] 

button 
Opens the advanced settings dialog. 

 

・Input method(When Key input (data) is selected)-Advanced settings 

dialog 

This dialog configures the check method for input data when input. 

 

 

Setting items 

Input check 

Number of 

digits 

You can set one of the following: not checked, all 

digits require input, input required (blank prohibited), 

or 0 inputs prohibited. 

Character 

type 

You can set one of the following: not checked, 

numeric only, alphabetic symbol only, kana only, 

alphanumeric symbol only, kana numeric only, or 

kana alphabetic symbol only. 
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・Input method(When Reference / Concatenate is selected)-Advanced 

settings dialog 

The dialog configures the details of the data reference/concatenate settings. 

 

 

Setting items Contents 

Type 

Selects the type of data to concatenate. 

Fix: Sets the value set in "Data". 

Browse: Duplicates the value of another object. 

Data Selects (when referencing) or inputs (when fixed) the data to set. 

Start digit Specifies which number of digit of the source data to start duplicated from. 

Number of digits 

Specifies number of digit of the data to be duplicated from the start digit. 

Data that is the target for duplication is always duplicated from the left 

justified with space filled state. 

Added type 
Specifies the filling method for digits when the number of digits in the 

referenced data is not sufficient. 

 

・Added type items 

Added type Filling method Example 

Not fill 

If the number of input digits is not 

sufficient, the actual data is not modified. 

Number of input digits: 5 digits, input: 

120 

⇒120 

Space-filling 

for left 

alignment 

If the number of input digits is not 

sufficient, the end of the actual data is filled 

with the number of digits worth of space 

characters. 

Number of input digits: 5 digits, input: 

120 

⇒ 120ss (s equals one space character) 

Space-filling 

for right 

alignment 

If the number of input digits is not 

sufficient, the front of the actual data is 

filled with the number of digits worth of 

Number of input digits: 5 digits, input: 

120 

⇒ss120 (s equals one space character) 
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space characters. 

0-filling for 

right 

alignment 

If the number of input digits is not 

sufficient, the front of the actual data is 

filled with the number of digits worth of "0" 

characters. 

Number of input digits: 5 digits, input: 

120 

⇒ 00120 

 

 
Setting items 

Function 

Table 
Sets the corresponding item to a conversion table. 

Select a table in the project with the list box and specify the table number to reference. 

# of data 

Specifies the maximum number of digits for the [Key input (data)] data. The maximum number 

of data digits that can be set is 1000. 

When using [Table], this specifies the maximum number of digits for the table reference value. 

Data 

Data 

Sets data to the item. 

When the input method is [Fix], the data set here is printed without modifications. 

For [Key input (data)], the data set here is used as the initial value for the input item when printing. 

(This becomes a fixed value when [The input value is made a fixed data] is selected in the detailed 

settings.) 

When using [Table], the value in the table converted with the data set as the key is printed. 

Dataset * This item can not use in SmaPri Designer 

[Detail] 

button 
When Input method [Key input (data)] is selected, display the detail setting dialog. 

 

・Data-Detail settings dialog 

 

Setting items 

Reference method 

The input value is made a fixed data 

This check box uses the value that is entered for [Data] 

as fixed data and not as the initial value. Input is 

possible after the value set with [Data].As an example, 

If 10 digits are set for # of data and 5 digits are input 

in [Data], the number of digits that can be input when 

printing is 5 digits. 
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Setting items 

Display 

Font 

Selects the type of font. 

Fonts that are named "Printer_XXXX" are SATO printer fonts. 

The characters that can be used is different according to the font type. 

Vt. size Specifies the vertical size of the font in points. 

Hr. size Specifies the horizontal size of the font in points. 

Pitch Specifies the pitch in points. 

Justify left Left justifies the text when less than the specified number of digits. 

Center 
Center justifies the text when less than the specified number of digits. This can 

be specified when the font type is set to Windows font. 

Justify right 

Right justifies the text when less than the specified number of digits. 

* The proportional font is the position of the right edge differs according to the 

content of the data. 

0-filling 

Zero fills the text when less than the specified number of digits. 

The position to zero fill the text is listed next. For left justify, 0 is added to the 

end of the data. For right justify, 0 is added to the beginning of the data. 

Eample: # of data: 5 digits, right justify, 0 fill, data [120] ⇒ [00120] 

Horizontal/vertical* 
Switches between horizontal text and vertical text. Depending on the font, 

vertical text cannot be specified. 

Line feed Specifies whether or not to break the line in a specified region. 

Reverse black and 

white 
Prints inverse printing. 

Not printed Select this check box to prevent the item from being printed. 

[Advanced] button Diplays the advanced setting dialog. 

* When set to vertical text, single-byte numbers, letters, and symbols in Designer 

are displayed on their side, which is different than their actual printed form. 

* Vertical text cannot be used when a Windows font is specified and the embedded 

TrueType font function is used. 
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・String Display Settings-Advanced setting dialog 

 

Setting items 

Character adjustment : 

These settings adjust the entire item, not single characters. The settings that can be used differ according to 

the printer type and character type. 

Bold* Makes the text bold. 

Italic* Makes italic text. 

Underline Underlines the text. 

Proportional Fills the pitch by the horizontal size of each character. 

Justify top Justifies the text at the top of the designated printing region. 

Justify vertical center Justifies the text in the center of the designated printing region. 

Justify bottom Justifies the text at the bottom of the designated printing region. 

Line feed settings 

Newline digits* Specifies the number of newline digits. 

Row pitch Specifies the character pitch with reference to the previous line when breaking the line. 

Line break 

symbol 

When the specified symbol is in the data in the item, the line is forcibly broken 

The forced line break symbol can also be specified as a combination of 2 or more 

characters. The specified characters are not reflected in the print data. 

Newline symbol 

The value set here is a guide when to break the line. When the word that is enclosed by 

the values stretches into the next line, even when in the range of the digits and in the 

region, the line is broken before hand when the previous word ends. The newline symbol 

can be used when enabled automatic line feed  or newline digits . 

* Newline digits cannot be used when a Windows font is specified and the embedded TrueType 

font function is used. And, bold and italic can not be set if the font itself does not correspond. 
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・Line feed setting details 

Line feeds operate according to the line feed settings method as shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

・Line break function conditions 

The line break settings change according to the font type and the input method. 

Font type 
TrueType font 

embedded 
Input method Auto LF 

Newline 

digits 

Line break 

symbol 

Newline 

symbol 

Printer font 
Enabled/ 

disabled 

Fix Enabled Enabled Enabled Usable 

Key input (data) Enabled Disabled Enabled Not usable 

Reference / 

Concatenate 
Enabled Disabled Enabled Not usable 

Windows font 

Disabled 

Fix Enabled Enabled Enabled Usable 

Key input (data)     

Reference / 

Concatenate 
    

Enabled 

Fix Enabled Disabled Enabled Usable 

Key input (data) Enabled Disabled Enabled Usable 

Reference / 

Concatenate 
    

 

  

Onion,Tomato,Beef,Flour,Pork,Sugar,Salt 

If newline digits are specified as "18"... 

If the newline symbol is specified as ","... 

Rayon    65%\nPolyester  30%\nPolyurethane   5% 

 

If the line break symbol is specified as "\n"... 
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・Reverse black and white 

Inverse printing is valid for the extent of the specified object. 

If you wish to arbitrarily specify the area to reverse black and white, paste a frame and 

inverse printing can be done. 

 

 

 

  

 

 

 

 

 

 

Right click on the frame and select bring to most forward on the menu.  

 

 

  

1. Paste a frame 

2. Reverse the 
frame 
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- Price object 

This window configures the settings for the price object. 

 

Setting items 

Item name Sets the item used in the layout design. 

Input method 

Fix Uses the value set for [Data]. 

Key input 
Uses the value that be input when printing. The value set in [Data] is the initial 

value. 

Browse 

References the value of another [price] item as the tax or discount calculation 

result. 

Items that can be referenced are only those items with the price calculation 

function turned on. 

[Advanced] 

button 
Diplays the advanced setting dialog. 

 

・Price-Advanced setting dialog 

This dialog sets the input range. 

 

 

  

Setting items 

Input range 

Minimum value 
Sets the minimum value for 

input. 

Maximum value 
Sets the maximum value for 

input. 
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Setting items 

# of data 

Specifies the maximum number of digits for the [Key input (data)]. The maximum number of 

digits is 10. To set a value after the decimal point, the decimal point is also included in the 

number of digits. You do not need to consider the currency symbol or the number of digits to 

fill. 

Data 

Data 

Sets data for the item. When the input method is selected as [Fix], the data set here is printed 

without modifications. For [Key input (data)], the data set here is displayed as the initial value 

for the input item when printing. The decimal point can only be input when Decimal point is set 

to a value other than 0 with [Advanced] under [Display]. 

Dataset * This item can not use in SmaPri Designer 

 

 

Setting items 

Display 

Font 
Selects the font type. "Printer_XXXX" are SATO printer fonts. 

That can be used characters is different according to the font type. 

Vt. size Specifies the vertical size of the font in points. 

Hr. size Specifies the horizontal size of the font in points. 

Pitch Specifies the pitch in points. 

Currency Sets the currency format for the price. 

Justify left Left justifies the text when less than the specified number of digits. 

Justify right 
Right justifies the text when less than the specified number of digits. 

* The right edge position of the propotional font differs according to the data. 

0-filling Not selectable 

Reverse black/white Prints inverse printing. 

Not printed Select this check box to prevent the item from being printed. 

[Advanced] button Displays the advanced setting dialog. 
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・Price-Advanced setting dialog 

This dialog configures the detailed settings for the price item. 

 

Setting items 

Character adjustment: 

These settings adjust the entire item, not single characters. The settings that can be used differ according to 

the printer type and character type. 

Bold Makes the text bold. 

Italic Makes italic text. 

Underline Underlines the text. 

Proportional Fills the pitch by the horizontal size of each character. 

Justify top Justifies the text at the top of the designated printing region. 

Justify vertical center Justifies the text in the center of the designated printing region. 

Justify bottom Justifies the text at the bottom of the designated printing region. 

Currency format (User defined): 

When the currency format is changed, the selected format in the currency format list will change according 

[(User defined)]. 

Currency mark Sets the position to fill in the currency symbol. 

Digit separator Sets whether or not to have a digit separator. 

Decimal point Sets the position of the decimal point. 

 

 
Setting items 

Others 

Use price calculation Tick the [Use Price Calculation] when refering to another price object. 

[Advanced] button Displays the advanced setting dialog. 
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・Price calculation- Advanced setting dialog 

This dialog configures the price calculation function. 

 
Setting items 

Price calculation 

Calculation 

process 

Sets the calculation process method. 

The setting item is different according to the [Tax rate/Discount] settings in 

the layout settings. 

[Tax rate]     :[None],[Tax included],[Tax excluded] 

[Discount] : [None],[Discount percent] 

Rounding Sets the rounding method when calculating the tax rate or discount rate. 

Digits for rounding Sets the number of digits when rounding. 

Tax rate/Discount Shows the tax rate or discount rate configured for the layout 

 

・ Price "Currency symbol", "Decimal separator symbol" and "Digit separator symbol" 

For the values of these items, the specified values are displayed on the currency tab in the 

layout settings. To modify those values, select the drop down currency list. 
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- Barcode object 

This window configures the settings for the barcode object. 

 

TIPS 

- Create a barcode with variable length digits 

 Please refer to 5-15. Creating a barcode with variable length digits. 

- Include line feed codes in QR code 

 Please refer to 5-16. Include line feed codes in QR code. 

 

 

 

Setting items 

Item name Sets the item used in the layout design. 

Input method 

Fix Uses the value set for [Data]. 

Key input 
Uses the value that be input when printing. The value set in [Data] is the 

initial value. 

Reference / 

Concatenate 

Copies an object, keys in fixed values and uses a value made of multiple 

object values combined. . 

[Advanced] 

button 
Opens the advanced settings dialog. 
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・Input method(When Key input (data) is selected)-Advanced settings dialog 

This dialog configures the input check settings. 

 

 

・ Input method(When Reference / Concatenate is selected)-Advanced settings dialog 

This dialog configures the data reference/concatenate settings. 

 

Setting 

items 
Contents 

Type 

Selects the type of data to concatenate. 

Fix: Sets the value set in "Data". 

Binary (QR code only): Sets the value set in "Data" as binary data. 

Browse: Duplicates the value of another object. 

Data Selects (when referencing) or inputs (when fixed) the data to set. 

Start digit Specifies which number of digit of the source data to start duplicated from. 

Number of 

digits 

Specifies number of digit of the data to be duplicated from the start digit. 

Data that is the target for duplication is always duplicated from the left justified with space 

filled state. 

Setting items 

Input check 

Number 

of digits 

You can set one of the following: all digits 

require input, input required (blank prohibited), 

or 0 inputs prohibited. 

Character 

type 

You can set one of the following: not checked, 

numeric only, alphabetic symbol only, or 

alphanumeric symbol only. 

C/D 

check 

You can set none, automatic generation, or 

check against input data. 

* Certain types of barcodes cannot be  

configured with the C/D setting. 
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Added 

type 

Specifies the filling method for digits when the number of digits in the referenced data is not 

sufficient. 

 

・Added type 

Added type Filling method Example 

Not fill 
If the number of input digits is not sufficient, 

the actual data is not modified. 

Number of input digits: 5 digits, 

input: 120 ⇒ 120 

Space-filling for 

left alignment 

If the number of input digits is not sufficient, 

the end of the actual data is filled with the 

number of digits worth of space characters. 

Number of input digits: 5 digits, 

input: 120 ⇒ 120ss (s equals one 

space character) 

Space-filling for 

right alignment 

If the number of input digits is not sufficient, 

the front of the actual data is filled with the 

number of digits worth of space characters. 

Number of input digits: 5 digits, 

input: 120 ⇒ ss120 (s equals one 

space character) 

0-filling for right 

alignment 

If the number of input digits is not sufficient, 

the front of the actual data is filled with the 

number of digits worth of "0" characters. 

Number of input digits: 5 digits, 

input: 120 ⇒ 00120 

 

 

 

Setting items 

Function 

Table 

Sets the corresponding item to a conversion table. 

Select a table in the project with the list box and specify the table number to 

reference. 

# of data 

Specifies the maximum number of digits for the [Key input (data)] data. The 

maximum number of data digits that can be set is 99. 

The start/stop code and the C/D auto check digit are not included. 

When using [Table], this specifies the maximum number of digits for the table 

reference value. 

Data 

Data 

Sets data to the item. 

When the input method is [Fix], the data set here is printed without modifications. 

For [Key input (data)], the data set here is used as the initial value for the input item 
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when printing. 

(This becomes a fixed value when [The input value is made a fixed data] is selected in the 

detailed settings.) 

When using [Table], the value in the table converted with the data set as the key is printed. 

Dataset * This item can not use in SmaPri Designer 

[Detail] button When Input method [Key input (data)] is selected, display the detail setting dialog. 

 

・Data-Detail settings dialog 

 

 

 

 

 

 

 

 

 

 
Setting items 

Display 

Barcode type Selects the type of barcode. 

Height 

Specifies the height of the barcode. 

The specification method of the height of barcodes with 

annotations differs according to the printer type. 

Narrow bar Specifies the narrow bar width. 

Bar ratio 

Sets the barcode ratio. 

Three types of barcodes can be configured with ratios: 

CODE39, CODABAR, and ITF. 

[Ratio setting] button Displays the [Ratio setting] dialog. 

Setting items 

Reference method 

The input value is made a fixed data 

This check box uses the value that is entered for 

[Data] as fixed data and not as the initial value. 

Input is possible after the value set with [Data].As 

an example, If 10 digits are set for # of data and 5 

digits are input in [Data], the number of digits that 

can be input when printing is 5 digits. 
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Add annotation 

Enables adding an annotation to the barcode. 

When an annotated barcode is selected for the barcode type, 

this check box cannot be selected. 

C/D auto add Enables automatically adding the check digit. 

Start code/Stop code Configures the start code and the stop code. 

Not printed Select this check box to prevent the item from being printed. 

[Advanced] button Displays the [Barcode Display Detail] dialog.  

 

 

・ Bar arbitrary settings – Advanced settings dialog 

When ratio setting is selected for barcodes that can be configured with a bar ratio, you can 

set the desired ratio configuration. 

 

 

・ Barcode Display Detail- Advanced settings dialog 

 

  

Setting items 

Bar arbitrary settings 

Narrow space line 
Specifies the narrow space width to 

configure for the barcode. 

Wide space line 
Specifies the wide space width to 

configure for the barcode. 

Narrow bar line 
Specifies the narrow bar line width 

to configure for the barcode. 

Wide bar line 
Specifies the wide bar line width to 

configure for the barcode. 

 

Setting items 

Annotation font details 

Font 
Selects the type of character font to use for 

the annotation 

Vertical size Sets the vertical size for the annotation. 

Horizontal 

size 
Sets the horizontal size for the annotation. 

Pitch Sets the pitch for the annotation. 

Row pitch 
Sets the distance from the barcode to the 

annotation. 
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・ Barcode and two-dimensional barcode types 

The types of barcodes and two-dimensional barcodes that can be configured with SmaPri 

Designer and the calculation method when the check digit is added and the start and stop 

codes that can be added are listed below. 

CODABAR (NW-7) and CODE39 must have start and stop codes added. 

When the check digit is added to CODABAR (NW-7), only numbers can be input. 

Name Check digit calculation 

method 

Start/stop code 

CODABAR (NW-7) 7 check A,B,C,D,E,N,T a,b,c,d,e,n,t 

CODE39 Modulo 43 * 

ITF Modulo 10, weight 3 - 

JAN13/EAN13 Modulo 10, weight 3 - 

JAN13/EAN13 with price C/D Modulo 10, weight 3 - 

JAN8/EAN8 Modulo 10, weight 3 - 

UPC-A Modulo 10, weight 3 - 

UPC-E Dedicated modulo 10 - 

CODE128 A code - (Modulo 103) *1 - 

CODE128 B code - (Modulo 103) *1 - 

CODE128 C code - (Modulo 103) *1 - 

GS1-128 (UCC/EAN128) - (Modulo 103) *1 - 

GS1 DataBar Omni-Directional  Modulo 10, weight 3 *2 - 

GS1 DataBar 

Stacked Omni-Directional  
Modulo 10, weight 3 *2 - 

QR code (model 2) - - 

 

*1: The check digit is automatically added by the printer. You do not need to add it to the 

data. The check digit is not displayed in the annotation. 

 

*2: The check digit that can be set with GS1 DataBar Omni-Directional and GS1 DataBar 

Stacked Omni-Directional is the GTIN (trade item identification code) check digit. The check 

digit to check the symbol configuration is automatically added by the printer. 

- GTIN (trade item identification code) check digit (modulo 10/weight 3) 

- Check digit (modulo 79) to check if the barcode symbol configuration is correct 

 

The specifications for UPC-A, UPC-E, and standard carton ID GS1-128 that can be created 
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with SmaPri Designer are listed below. Please be aware of the specifications when using the 

barcodes. 

 

  

Barcode 

type 

Number 

of input 

digits 

C/D 

auto add 

Data processing/ 

input advanced 

settings 

Barcode data and annotation 

UPC-A 11 digits Always on Not configurable 
Barcode: 0 fill + 11 input digits + C/D 

Annotation: 11 input digits + C/D 

UPC-E 6 digits Always on Not configurable 
Barcode: 6 input digits + C/D 

Annotation: 0 fill + 6 input digits + C/D 

GS1-128 17 digits Always on Not configurable 
Barcode: 00 fill + 17 input digits + C/D 

Annotation: (00) + 17 input digits + C/D 
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- Date time object 

This window configures the settings for the date time object. 

 

 

Setting items 

Item name The name of the item used in the layout design. 

Input method 

Not add value 
Prints the date on the terminal that issues the print instruction 

when printing. 

Add value 

When printing, adds the set value to the date on the terminal 

that issues the print instruction and then prints. Use this for 

expiration dates and best-by dates. 

Added value 

Specifies the value to add to the date of the date time object.  

The maximum value that can be set is 9 for years, 99 for months, 

and 999 for days and hours. 

Add unit Select year, month, day, hour. 

Add value reference 
Prints by adding a value that references information input in 

another field. 

Data set * This item can not use in SmaPri Designer 

Field 
Select a field name that you want to copy when you use [Add 

value reference]. 

Change at printing 
Select this check box when it is necessary to change the added 

value at printing. 

[Detail settings] button Displays the Detail setting dialog. 
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・Add value reference -Detail setting dialog 

This dialog configures the reference digits for the added value reference target field and the 

separate description settings. 

  

 

 

 

 

Setting items 

# of data 
This setting is automatically calculated from the number of digits for the string 

set by the date format, the separator, and the time format under View. 

View 

Font 

Selects the type of font. 

Fonts that are named "Printer_XXXX" are SATO printer fonts. 

The characters that can be used is different according to the font type. 

Vt. size Specifies the vertical size of the font in points. 

Hr. size Specifies the horizontal size of the font in points. 

Setting items 

Add value reference 

All digits 

This setting allows you to specify all the 

digits of the added value reference target 

field. 

Specified 

digit 

This setting allows you to specify arbitrary 

digits of the added value reference target 

field. 

Separate 

description 
* This item can not use in SmaPri Designer 

Separate 

description 
* This item can not use in SmaPri Designer 
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Pitch Specifies the pitch in points. 

Date format 
Selects the date format. 

When User defined is selected on the list, the [User defined] button is enabled. 

Separator 
Sets the character to separate the date view and the time view. 

A space is set as the initial value. 

Time format 
Selects the time format. 

When User defined is selected on the list, the [User defined] button is enabled. 

Justify left Left justifies the text when less than the specified number of digits. 

Center 
Center justifies the text when less than the specified number of digits. This can 

be specified when the font type is set to Windows font. 

Justify right Right justifies the text when less than the specified number of digits. 

Justify Aligns the horizontal width of the characters in the designated printing region. 

Reverse black and white Prints inverse printing. 

Not printed Select this check box to prevent the item from being printed. 

[Detail settings] button Displays the [Detail] dialog.  

[User defined] button Displays the [User defined] dialog. 

Settings 

Active time printing * This item can not use in SmaPri Designer 

View at printing * This item can not use in SmaPri Designer 

Refer 
Allows references from other items. 

Please refer to the [Referencing the date time object] for details. 

 

・Detail-Detail setting dialog 

 

 

 

 

  

Setting items 

Character adjustment : 

These settings adjust the entire item, not single characters. 

The settings that can be used differ according to the character type. 

Bold Makes the text bold. 

Italic Not selectable 

Underline Not selectable 

Proportional Not selectable 

Justify top Not selectable 

Justify vertical center Not selectable 

Justify bottom Not selectable 
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・User defined 

This dialog configures the user defined date format and time format. 

These settings can only be configured when "User defined" is selected for date format or time 

format. 

The number of digits that can be set is 32 characters (double-byte 16 characters) or less including 

the date, hour, minute, and separator. 

 

Setting items 

Date format(User defined) 

Day format 

 

Sets the date format. 

The date format can be specified by a combination of the letters below and characters 

such as "/". However, a comma cannot be set. 

[Available format] 

YY : Year (2 digit) 

WW : Japanese calender (A.D. + lower 2 digits of calendar conversion value) 

gggg : Era name (4 digits, acquired from user settings) 

MM : Month 

MMM : Month (letter notation) 

DD : Day 

"Month/day" 

filling 

Selects the filling method for a 1-digit month or day. 

For YY, the year is 0 filled. For WW, it is displayed with spaces without filling. 

Arbitrary designations are not possible. 

Time format 

The time format can be specified by a combination of the letters below and characters 

such as ":". However, a comma cannot be set. 

[Available format] 

hh: Hour (24-hour time) 

HH: Hour (12-hour time) 

mm: Minute 

TT: AM/PM 

t t: am/pm 

TTTT: 午前/午後（Kanji） 

"Hour" filling Selects the filling method for a 1-digit hour. 

"Minute" filling Selects the filling method for a 1-digit minute. 
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・Referencing the Date time object 

When [Refer] is enabled from the settings options, [reference/concatenate] allows you to 

select a format from other objects. Use this function to display the date and time in a barcode, 

for example. 

 

* The original date time object "Day of the week" information can be acquired as a 

number only when references are allowed. 

0: Sunday, 1: Monday, 2: Tuesday, 3: Wednesday, 4: Thursday, 5: Friday, 6: Saturday 

 

 

・Referencing the added value from another object 

When the added value is "Add value", "Separate description" is not selected, and "Refer" is 

selected, the added value can be referenced from another object. 

Other objects that can be referenced 

・ String object 

・ Barcode object 

・ Date time object (no self-referencing) 

・ Switching graphic (The added value can be referenced as the graphic entry number) 

 



 
SmaPri Designer Operation Manual 

 

 

66 

- Counter object 

This window configures the settings for the counter object. The counter can be configured to 

increment or decrement one at a time. 

The maximum number of counters that can be configured on a single layout is 8. 

 
Setting items 

Item name The name of the item used in the layout design. 

Input method 

Fix The value set for [Data] becomes the initial value for the counter. 

Key input (data) 

Sets the input method to data that can be input (modified) when printing. 

The value set in [Data] is the counter start value, and it can also be displayed on 

the screen during printing. 

Reference 

 / Concatenate 
References the value of a separate item as the start value of the counter. 

[Advanced] button Opens the advanced settings dialog. 

 

・Input method(Reference / Concatenate)-Advanced settings dialog 

The dialog configures the details of the data reference/concatenate settings. 

 

Setting items Contents 

Type Selects the type of data to concatenate. 

Data 

Selects the data to set. Enables you to browse an item only when you set the input 

method as [key input] on the string object and you set [Input check] as [numeric 

only] for the [character type] . 

Start digit Specifies which number of digits of the source data to start duplicate from. 

Number of digits 

Specifies number of digit of the data to be duplicated from the start digit. 

Data that is the target for duplication is always duplicated from the left justified with 

space filled state. 

Added type Cannot be changed. [0-filling for right alignment] is selected. 
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Setting items Contents 

Function 

Increment/Decrement Sets whether the counter increments or decrements. 

# of data 

Specifies the maximum number of digits for the [Key input (data)] 

data. 

The maximum number of data digits that can be set is 8. 

Data 

Data 

Sets data for the item. 

For [Fix], the data set here is the counter start value. For [Key input 

(data)], the data set here is displayed as the counter start value on 

the input screen when printing. 

Dataset * This item can not use in SmaPri Designer 

 

 

Setting items Contents 

Display 

Font 

Selects the type of font. 

Fonts that are named "Printer_XXXX" are SATO printer fonts. 

The characters that can be used is different according to the font type. 

Vt. size Specifies the vertical size of the font in points. 

Hr. size Specifies the horizontal size of the font in points. 

Pitch Specifies the pitch in points. 

Justify left Not selectable 

Center Not selectable 

Justify right Not selectable (Always Enable） 

Justify Not selectable 
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0-filling Not selectable (Always Enable） 

Reverse black and white Not selectable 

Not printed Select this check box to prevent the item from being printed. 

[Advanced] button Opens the Detail dialog. 

 

・Detail-Detail setting dialog 

 

・Counter object references from other objects 

The value of a counter object can only be referenced from a string object or a barcode 

object. 

When referencing, there are conditions and limitations, so note the items below. 

 

Object type 

Conditions and limitations 
String object Barcode object 

Font type Set to font other than 

Japanese kanji 

Set to font other than 

Japanese kanji 

Reference multiple counters on the 

Reference / Concatenate Detail dialog. 
No No 

Reference an item that references a 

counter (secondary reference) 
No No 

 

Setting items 

Character adjustment : 

These settings adjust the entire item, not single characters. 

The settings that can be used differ according to the character type. 

Bold Not selectable 

Italic Not selectable 

Underline Underlines the text. 

Proportional 
Fills the pitch by the horizontal size of 

each character. 

Justify top 
Justifies the text at the top of the 

designated printing region. 

Justify vertical center 
Justifies the text in the center of the 

designated printing region. 

Justify bottom 
Justifies the text at the bottom of the 

designated printing region. 
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- Fixed graphic object 

This window configures the settings for the fixed graphic object. 

 

 

Setting items 

Item name The name of the item used in the layout design. 

Graphic selection 

Embedded graphic 

Specify the file to embed on the layout with 

the [Select] button to paste it on the design 

window. 

If the selected graphic is color, the graphic is  

imported after you select the dithering 

method. 

 

Embedded graphics are imported into the tool. The graphic does not 

disappear, even if the original file is deleted. 

Clear 
Clears the embedded graphic and the SATO logo graphic that is the 

default when pasting a fixed graphic and clears the selection. 

Graphic(fixed) * Not usable with SmaPri Designer 

Graphic(data set) * Not usable with SmaPri Designer 

Change at printing 
Specifies and prints a graphic that is in the Issuing terminal when 

printing. 

Dithering setting 

Selects the dithering method to create the monochrome graphic when 

printing if the imported graphic is color. 

[Characters / shapes (Threshold)], [Images / Pictures (Error 

diffusion)]  
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Setting items 

Size 

Area settings 
The area displaying the graphic data is specified in millimeters for height 

and width you set. 

Magnification 

settings 

Specifies the height and the width for the graphic data size as a 

percentage. The original size is 100%.  

To modify the graphic size, you can also drag the object on the design 

window. 

Fix horizontal and 

vertical ratio 

Displays the graphic data without changing the aspect ratio. 

The aspect ratio is also maintained when zooming in or out after 

embedding the graphic. 

Display 

Align graphic left Left aligns the graphic when the image size is less than the specified area. 

Align graphic center Centers the graphic when the image size is less than the specified area. 

Align graphic right 
Right aligns the graphic when the image size is less than the specified 

area. 

Top align Top aligns the graphic when the image size is less than the specified area. 

Middle align Centers the graphic when the image size is less than the specified area. 

Bottom align 
Bottom aligns the graphic when the image size is less than the specified 

area. 

Reverse black and 

white 
Prints reversing black and white. 

Non printable Select this check box to prevent the item from being printed. 
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・Settings to embed image data imported by the terminal's camera or paint 

software on the label 

 

Configure the fixed graphics settings as shown below. 

"Change at printing + Area settings + Fix horizontal and 

vertical ratio" 

 

With the above settings, even when the number of pixels in 

the image data differs by terminal, and the aspect ratio of the 

image data differs by terminal, the area can be filled with the 

image data while maintaining the aspect ratio. 

 

Example: 

When you want to print the two hand-written signatures with 

different aspect ratios below in a 10 mm x 30 mm specified 

area 

 

1) 5 mm x 20 mm image 

 

The (1) image is enlarged to a maximum of 1.5x the original size in the area. 

 

 

2) 10 mm x 20 mm image 

 

The (2) image has the same height as the specified area, so the original size. 
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When the aspect ratio for the graphic area and the aspect ratio for the imported image data 

are different, white space occurs vertically or horizontally.  

This white space can be adjusted by the toggle buttons under "Display". 

 

Example of adjusting the display when white space occurs 

 

 

How to display image data in an area with a fixed aspect ratio 

The image data has enlarged/shrunk to the maximum size that can be displayed in the 

specified area and displayed in the area while maintaining the aspect ratio of the original size 

of the imported graphic data (or graphic data that will be imported at printing). 

 

Example: Original graphic (6mm H x 6mm W) 

 

 

Height only enlarged to 10 mm 

(10 mm H x 6 mm W) 

Width only enlarged to 10 mm 

(6 mm H x 10 mm W) 

Height and width enlarged to 10 mm 

(10 mm H x 10 mm W) 
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- Switching graphic object 

This window configures the settings for the switching graphic object. 

 

Setting items 

Item name Sets the item used in the layout design. 

Input method 

Fix Uses the value set for [Data]. 

Key input 
Uses the value that be input when printing. Input the Registration number. 

The value set in [Data] is the initial value. 

Reference / 

Concatenate 

Copies an object, keys in fixed values and uses a value made of multiple 

object values combined. . 

[Advanced] 

button 
Opens the advanced settings dialog. 

 

・Input method(When Key input (data) is selected)-Advanced settings 

dialog 

This dialog configures the check method for input data when it is input. 

 

  

Setting items 

Input check 

Number 

of digits 

You can set either not checked or 

input required (blank prohibited). 
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・Input method(Reference / Concatenate)-Advanced settings dialog 

The dialog configures the details of the data reference/concatenate settings. 

 
Setting 

items 
Contents 

Type 

Selects the type of data to concatenate. 

Fix: Sets the value set in "Data". 

Browse: Duplicates the value of another object. 

Data Selects (when referencing) or inputs (when fixed) the data to set. 

Start digit Specifies which number of digit of the source data to start duplicate from. 

Number of 

digits 

Specifies number of digit of the data to be duplicated from the start digit. 

Data that is the target for duplication is always duplicated from the left 

justified with space filled state. 

Added type 
Specifies the filling method for digits when the number of digits in the 

referenced data is not sufficient. 

 

・Added type items 

Added type Filling method Example 

Space-filling for 

left alignment 

If the number of input digits is not sufficient, 

the end of the actual data is filled with the 

number of digits worth of space characters. 

Number of input digits: 5 digits, 

input: 120 ⇒ 120ss (s equals one 

space character) 

Space-filling for 

right alignment 

If the number of input digits is not sufficient, 

the front of the actual data is filled with the 

number of digits worth of space characters. 

Number of input digits: 5 digits, 

input: 120 ⇒ ss120 (s equals one 

space character) 

0-filling for right 

alignment 

If the number of input digits is not sufficient, 

the front of the actual data is filled with the 

number of digits worth of "0" characters. 

Number of input digits: 5 digits, 

input: 120 ⇒ 00120 
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Setting items 

Data 

Data selection list box 
Selects the graphic table data. If "(Not selected)", the switching 

graphic on the layout is the SATO symbol (not printed). 

Dataset * This item can not use in SmaPri Designer 

Display 

Reverse black and 

white 
Prints inverse printing 

Not printed Select this check box to prevent the item from being printed. 
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- Line object 

This window configures the settings for the line object. 

 

Setting items 

Item name The name of the item used in the layout design 

Line 

Line length Specifies the length of the line in millimeters. 

Line width Specifies the width of the line in millimeters. 

Direction Specifies horizontal or vertical as the line direction. 

Display 

Reverse black and 

white 
Prints reversing black and white. 

Not printed Select this check box to prevent the item from being printed. 
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- Frame object 

This window configures the settings for the Frame object. 

 

Setting items 

Item name The name of the item used in the layout design 

Size 

Height Specifies the height of the frame in millimeters. 

Width Specifies the width of the frame in millimeters. 

Frame 

Line width Specifies the width of the line in millimeters. 

Round corner 

Specifies the radius for rounding the corners of the frame line. 

This setting can only be set when a compatible printer type is 

selected. 

Display 

Reverse black 

and white 
Prints reversing black and white. 

Not printed Select this check box to prevent the item from being printed. 

 

 



 
SmaPri Designer Operation Manual 

 

 

78 

- Table object 

This window configures the settings for the table object. 

 

Setting items 

Item name The name of the item used in the layout design. 

Size 

Height Specifies the height of the table in millimeters. 

Width Specifies the width of the table in millimeters. 

Table 

# of rows Specifies the number of rows in the table. 

# of columns Specifies the number of columns in the table. 

Row Specifies the horizontal line specified at the position from the top edge. 

Column Specifies the vertical line specified at the position from the left edge. 

Height Specifies the position of the horizontal line specified by Row from the top edge. 

Width Specifies the position of the vertical line specified by Column from the left edge. 

Hr. line width Specifies the width of the horizontal lines in the table. 

Vt. line width Specifies the width of the vertical lines in the table. 

Frame width Specifies the width of the frame lines for the table. 

Round corner 
Specifies the radius for rounding the corners of the table frame. 

This setting can only be set when a compatible printer type is selected. 

Display 

Reverse black and white Prints reversing black and white. 

Not printed Select this check box to prevent the item from being printed. 
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- Command object 

This window configures the settings for the command object. With this object, you can 

directly set commands to output. 

 

Setting items 

Item name The name of the item used in the layout design. 

Input method 

Fix Uses the value set for [Data]. 

Reference 

 / Concatenate 

Copies an object, keys in fixed values and uses a value made of multiple object values 

combined. . 

[Advanced] 

button 
Opens the Reference / Concatenate Detail dialog. 

Data 

Data 

When the input method is selected as [Fix], the data set here is output as SBPL 

commands without modifications. You must set data that also includes the escape 

command <ESC>. 

Please input the escape command <ESC> with the substitute character specified on 

the [Data properties] dialog. 

[Detail] button Opens the Detail dialog. 

Output 

Add positioning 

command 

For command data set by "Fix" and "Browse, you can output data by adding the 

command for the position where the "command object" was pasted. 

Non printable This setting prevents the set command data from being output. 

Send timing 
Selects the timing of sending command. Choose from “Include with print data”, 

“Output before print data”, “Output after print data”. 
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If “Add positioning command” is checked, send timing is fixed to “Include with print 

data”. 

 

 

・Advanced settings dialog 

 The dialog configures the details of the data reference/concatenate settings. 

 
Setting items Contents 

Type 

Selects the type of data to concatenate. 

Fix:  Sets the value set in "Data". 

Binary: Sets the value set in "Data" as binary data. 

Browse: Duplicates the value of another object. 

Data Selects (when referencing) or inputs (when fixed) the data to set. 

Start digit Specifies number digit of the source data to start duplicating 

Number of 

digits 

Specifies up to number of digit of the data to duplicate from the start digit. 

Note: Data that is the target for duplication is always duplicated from the 

left justified space filled state 

Added type 
Specifies the filling method for digits when the number of digits in the 

referenced data is not sufficient. 
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・Added type items 

 

Added type Filling method Example 

Not fill 
If the number of input digits is not 

sufficient, the actual data is not modified. 

Number of input digits: 5 digits, 

input: 120 ⇒ 120 

Space-filling for 

left alignment 

If the number of input digits is not sufficient, 

the end of the actual data is filled with the 

number of digits worth of space characters. 

Number of input digits: 5 digits, 

input: 120 ⇒ 120ss (s equals one 

space character) 

Space-filling for 

right alignment 

If the number of input digits is not sufficient, 

the front of the actual data is filled with the 

number of digits worth of space characters. 

Number of input digits: 5 digits, 

input: 120 ⇒ ss120 (s equals one 

space character) 

0-filling for right 

alignment 

If the number of input digits is not sufficient, 

the front of the actual data is filled with the 

number of digits worth of "0" characters. 

Number of input digits: 5 digits, 

input: 120 ⇒ 00120 

 

 

・Detail dialog 

 

 

 

 

 

Setting items 

Data settings 

Escape character 

Specifies the substitute character for the escape 

command <ESC> when setting SBPL 

commands in [Data]. 

The string specified here is converted to the 

escape character (0x1b) when data is output. 
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The 5th chapter: Special Operations  

 

 

Special 

Operations 

The 5th chapter 
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5-1. Table function 

5-1 
Table function 

- Table – Graphic table 

SmaPri Designer features a table function that converts numeric values that are input to 

register text data. 

By inputting numeric values with a maximum of 4 digits, you can convert those values to fix 

Japanese kanji data and print them, and easily mistaken barcode input can also be converted 

from 1 to 4 digit numbers. 

The table data can also be shared and used across multiple layouts. 

Tables can be registered up to 99 tables in a single project. 

 

 

Manual operation button 

Insert rows This button can insert a new row above the selected row. 

Delete rows This button can delete the selected row. 

Import 

An external file can be imported as table data. 

The file formats are CSV files, tab delimited text files, and table files (files for 

the project). 

Export 

The table data can be saved as an external file. 

The file formats are CSV files, tab delimited text files, and table files (files for 

the project). 

 

  

 

Values input by the terminal 
issuing the print instruction 
0 to 9999 can be input 
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- CSV and tab delimited data that can be imported. 

No header data 

Registration No. (Comma or tab) Content CR+LF 

0 to 9999 Separator Digits specified by number of digits (32 

max) 

Line feed code 

 

Comma separated data example 

  Tab delimited data example 

 

 

 

 

 

 

 

 

 

Data with header information 

1st row 

Table number (Comma 

or tab) 

Number of digits (Comma 

or tab) 

Table name CR+LF 

01 to 99 Separator 01 to 16 table name 

number of digits 

Separator String 16 characters max Line feed 

code 

From 2nd row 

Registration 

No. 

(Comma 

or tab) 

Number of digits (Comma 

or tab) 

Content CR+LF 

0000 to 9999 Separator 01 to 32 value number 

of digits 

Separator Digits specified by number 

of digits (32 max) 

Line feed 

code 

 

 

  

Header 

Data 
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- Table registration steps 

1) On the menu bar, select [New] > [Table]. 

The table can also be 

registered on the project 

window with [Project folder] 

> [New] > [Table], or if 

there is already a table 

folder on the project 

window, table folder > 

[New]  

The table can also be 

created with [New] on the 

toolbar. 

  

2) The edit (register) table window opens. 

 

3) Enter the value to input at printing in Registration No. and the value to print after 

conversion in Value. 

You can register a 1 to 4 digit number in Registration No. and text 1 to 32 characters long 

(double-byte 16 characters) for Value. 

 

4) When finished registering entries, click the [Close] button to save the table and close 

the window. 
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- For a graphic table 

1) On the project window, double click the graphic table. 

 

 

2) The edit (register) table window opens. In Registration No., enter the value to input and 

enter the graphic name, then click the (Browse) button. 

 

 

3) Select the graphic file you want to register and click the [Open] button. 
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4) When finished registering entries, click the [Close] button to save the table. 

 

 

 



 
SmaPri Designer Operation Manual 

 

 

88 

- Table importing steps 

※The graphic table is similar operation. 

 

 

 

 

 

 

 

 

  

Double-click the table that you want to input data. 1 

 

Click the [Import] button. ２ 

 

Select the file. ３ 

 

Click the [Open] button. ４ 
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[The case that select the Remove] 

 

 

[The case that select the Add/Update】 

 

 

[Remove]  Delete all existing data and then new data 

will be stored. 

[Add/Update] Existing data will be remained, the data 

will be updated if the same data numbers are existed, 

or the data will be added if the same data numbers are 

not existed. 

Select the processing method of existing data. ５ 

 

Click the [OK] button. 

The original data is deleted and then CSV data will be stored. 

CSV data is added to the original data. 
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- Table data, Search and Replace 

※The graphic table is similar operation. 

 

 

 

 

[Search] 

 

 

 

 

 

 

Double-click the table 1 

 

Click the Search/Replace 2 

 

 

Input words in [Search string] 3 
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Sellect [Search target], you can narrowing search ※ 

 

 

  Click [Search next] 4 

 

 

Cursor is set the cell. The cell includes [Search string]. 

Click [Search next], 

Search other cell that includes [Search string]. 
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[Replace] 

 

 

 

 

 

 

Note: Cancel the replacement 

 

 

Click [Replace all] 4 

 

Replaced ‘item’ by ‘ITEMS’ 

Click [OK] 5 

 

Sellect [Search target], 

you can narrowing replace 

※ 

 

 

Click ‘Undo’ (Right click menu) 
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5-2. Preview test print function  

5-2 
Preview test print function 

- Preview test print 

 

Using a created layout, this function displays the preview of the results that are input with 

data by the terminal that issues the print instruction, and it then allows you to check the 

results printed by the printer. 

 

 

- In the cases of other than variable-length receipt paper 

1) On the toolbar, click the [Preview test print] button. 

You can also perform the same action on the menu bar with [File] > [Preview test 

print]. 

 

2) The preview test print window is displayed. 

 

3) Enter a value in the input value fields. 

 

 

* An error message is displayed if an invalid value is input. 

 

4) Click the preview button after entering the print quantity to display the preview 

window. On the preview window, you can check the number of pages for the quantity. 

However, the quantity is limited to 9. 

Note: above the preview 
When using the embedded TrueType font function, the text, the shape of the text, and the position 
of line feeds may differ between the preview display and the actual printer results due to the 
differences between the Windows operating system and the Android operating system. 
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5. Select the printer on the printer list and click the test print button to print the test. The 

printer list shows all the SATO printer drivers installed on the PC. Select the printer type 

configured on the printer settings tab. 

If you select a different printer, the test may not print correctly. 

 

- In the case of variable-length receipt paper 

1) On the toolbar, click the [Preview test print] button. 

You can also perform the same action on the menu bar with [File] > [Preview test 

print]. 

 

 

2) The preview test print window is displayed. 

 

3) Add a Layout. 

 

 

 

*A layout can be added continuously. 
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4) Enter a value in the input value fields. 

 

 

 

* An error message will be displayed if an invalid value is entered. 

 

5) Click the preview button after entering the print quantity to display the preview 

window. On the preview window, you can check the number of pages for the quantity. 

However, the quantity is limited to 9. 

 

6) Select the printer on the printer list and click the test print button to print the test. The 

printer list shows all the SATO printer drivers installed on the PC. Select the printer type 

configured on the printer settings tab. 

If you select a different printer, the test may not print correctly. 
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5-3. Data output   

5-3 
Data output 

- Outputs the format files to be used by the SmaPri Driver 

- Data output steps 

1) On the toolbar, click the [Data output] button. 

You can also perform the same action on the menu bar with [File] > [Data output]. 

 

 

2) The archive output dialog is displayed. 

 

3) Specify the destination for the data and click the save button. 

If you are using TrueType font embedding function, you can choose whether to include 

TrueType font file in format file. 

 

If the license key (HASP) cannot be recognized when saving, the following message is 

displayed. 
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4) When finished, Project name, data output date and time, file size are displayed. 

Click the [OK] button. 

 

 

Double-click on the output format file (* .spfmtz) on Windows, the same contents (project 

name, data output date and time, file size) as when saved are displayed. 
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- SmaPri Designer output files 

The file output with the "Data output" button that has the spfmtz extension is a SmaPri 

Driver file. The SmaPri Designer project created with the "Save project" file that has the 

spproz extension is a SmaPri Designer file. 

 

←SmaPri Driver format file icon 

 

←SmaPri Designer project file icon 

 

 

SmaPri Designer and SmaPri Driver relationship diagram 

 

 

The icons look similar, so be careful not to mistake them. 
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5-4. Global change tax rate 

5-4 
Global change tax rate 

- Change the tax rate settings in the project in batch. 

The tax rate for all layouts will be changed in batch. 

You cannot undo this change, so use caution when different tax rates are set according to 

layout. 

 

- Global change tax rate steps 

1. On the menu bar, select [Tool] > [Convert] > [Global change of tax rate]. 

 

 

2. Enter the new tax rate and then click the [OK] button. 

The tax rate can be changed as an integer value. 

 

 

3. Press the [OK] button to display the message. Check the modified value and press the 

[OK] button. 
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5-5. Change object type 

5-5 
Change object type 

- Change the type of an object. 

- The types of objects that can be changed 

  "string" and "price". 

 

- Change object type steps 

1. Select the object you want to change and right click to display the menu. 

2. On the menu, select [Change object type]. 

 

3. A warning message when changing the object type is displayed. Press the [OK] button. 

When the object is changed, a portion of price object functions such as the "\" (yen) 

and "," (comma) fill function and auto calculation function are disabled. 

 

4. Check the object type after the change and press the [OK] button. 

 

 

  

Right click when selected 
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5-6. Barcode wizard 

5-6 
Barcode wizard 

This feature to create a barcode of various combinations in wizard-type form. 

 

- Supported barcode symbol 

- JAN13 (JAN13 price C/D) 

- JAN8 

 

- Barcode wizard usage steps 

1) Click "Barcode wizard" button in Object bar. 

 

 

2) The cursor changes to "Cursor when pasting objects". Please click anywhere in design 

window. 
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3) Will display "Barcode wizard" dialog. Inputting object name at "Item name" box and click 

"Next". "Item name" can be set up to 16 characters. 

 

 

4) Select to "Barcode type" in list box. Click "Next". 

 

 

5) Select to "Barcode composition" and click "next". 

If resistrer new barcode composition, please refer to "Resister new barcode composition".  
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6) Set to detail and click "next". 

 

Setting items Contents 

Type Type of data. 

Key input Key input when printing. 

Fix Fixed item. 

Browse Copy from other object value. 

Item name 
The name of the item used in the layout design. 

"Item name" can be set up to 16 characters. 

Data This item value is default value of "Key input", or value of "Fix". 

Start digit If selected "Browse" on Type, specifies whether to copy from what digit.  

Number of digits Digits of this item’s data. 
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7) Sets detail setting of barcode. After setting, click "Finish". 

 

Setting items Contents 

Height Specifies the height of the barcode. 

Narrow bar width Specifies the narrow bar width. 

Annotation Specifies annotation and guard bar. 

Preview 
Previewing barcode image. 

Aspect ratio is accurate, but the scale is not accurate. 

[Advanced] button Displays the [Barcode Display Detail] dialog. 

 

 

8) Barcode object will create in design window. 

 

 

 

Setting items 

Annotation font details 

Font 
Selects the type of character font to use for 

the annotation 

Vertical 

size 
Sets the vertical size for the annotation. 

Horizontal 

size 
Sets the horizontal size for the annotation. 

Pitch Sets the pitch for the annotation. 

Row pitch 
Sets the distance from the barcode to the 

annotation. 
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9) Barcode that was created by the wizard, it is limited to the setting item. 

You can not change setting of "Input method", "Barcode type" and "C/D auto add". 

[Created by the wizard] [Normal] 
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- Resister new barcode composition 

1) Click "New" button at "Barcode composition selecting" of barcode wizard. 

 

 

2) Input "Item name" and "Number of digits". Click "Register", if finished input. 

 

 

3) The new barcode composition will be added in the list in blue text and [Item name(digits)] 

format. 

 

 

When you register to a certain digit, 

"C/D" will be added automatically. 

JAN13: 12 digits 

JAN8: 7 digits 
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If barcode type is "JAN13", be can used price C/D by turned on "Price". 

"Price C/D", "Price" and "C/D" will be added automatically. 

 

 

When you register to a certain digits, 

"C/D" will be added automatically. 

JAN13: 7 digits 
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5-7. Grid settings 

5-7 
Grid settings 

- Display a grid on the design window as a guide to help in the placement of objects. 

 

You can show or hide the grid with the grid button the toolbar or [View] > [Grid] on the menu 

bar. 

Toolbar grid button Menu [View] > [Grid] Grid is shown 

 

 

 

 

- Changing the grid interval 

1) On the menu bar, click [Tool] > [Grid]. 

 

 

2) The grid settings dialog is displayed. Enter the grid interval and confirm it with the [OK] 

button. The grid can be set in 0.25 mm increments. 
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5-8. Tool settings 

5-8 
Tool settings 

- Configures the tool settings 

 

On the menu bar, select [Tool] > [Settings]. 

 

 

- Tax rate tab 

This tab configures the initial value for the tax rate when a new layout is created. 

 

- Printer tab 

Specify the printers that are displayed on the printer selection window. 

 

 

  

 

Enter the tax rate as an integer value and press the [OK] 

button. 

The tax rate set here is applied to newly created layouts. 

To modify the tax rate for existing layouts, configure them 

with "Layout settings". 
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- Language tab 

Select the display language for SmaPri Designer.  

 

 

- Option tab 

This tab configures settings related to tool operation. 

 
Setting items Contens 

Show the layout selection screen 

when creating a new project 
* This item can not use in SmaPri Designer 

Use the Windows fonts 
Select this check box to allow the selection of 

Windows fonts. 

Allow refer printer No. * This item can not use in SmaPri Designer 

Show the property window 
Select this check box to display the object settings 

on the property window. 

Allow to save as individual files. 

(Non archive) 
* This item can not use in SmaPri Designer 

Make backup file with archive 

output 

When running data output, saves a backup of the 

SmaPri Designer project file in the archive file. 

Show menu of external data * This item can not use in SmaPri Designer 
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import 

Display all messages 

Display messages again that have been dismissed 

by selecting the "Do not display this dialog again" 

check box. 

Era Display [JP Year settings] dialog. 

 

- JP Year setting 

Set the era name and the Japanese year, then press the [OK] button. 

 

 

Setting items Contens 

Era name Sets the era name as 2 or fewer kanji characters. (Can also be blank) 

Christian era Shows the current western year from the system date of the PC. 

JP Year Enter the current Japanese year as 2 digits from 1 to 99. 

Offset 
Calculates and displays how many years the set Japanese year is offset 

from the last 2 digits of the western year. 
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5-9. Object grouping function 

5-9 
Object grouping function 

- You can select multiple objects on the layout and organize them into a single group. 

 

This is useful for moving or rotating the grouped objects. 

 

- Grouping steps 

1) Select the objects you want to group on the layout. 

 

 

2) Right click on the selected objects and select [Grouping] > [Grouping]. 

 

 

3) The selected objects are grouped. 
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Benefit 1: Objects can be moved as a group when editing the layout (no missed 

selections) 

 

 

Benefit 2: Objects can be rotated without disturbing their positional relationship 

If you select all objects and rotate... If you group and then rotate... 

  

 

You can also configure each object when they are grouped 

 

 

Each individual 
object rotates... Rotated maintaining 

the position 
information! 

When objects are grouped... 

Twice click and you can select 

each object in group. 
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5-10. Importing sample data 

5-10 
Importing sample data 

- You can create the layouts by using these samples for each printer. 

 

You can reduce the time required to create layouts by using these samples. 

 

- Sample usage steps 

1) On the toolbar, click the [Import sample] button. 

 

 

2) The sample selection window opens. 

 

3) Directly select a sample on the displayed list or refine the sample by [Layout type], 

[Category], and [Size]. 

 

4) Select and click the layout similar to the image of the layout you want to create. 

 

 

If a new project was created, the save 

project message is displayed. 

Follow the message and save the project. 
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5) If there are multiple groups in the project currently being edited, select the group. After 

registering, you can change the group by [Cut] and [Paste] in the project window. 

 

 

6) The imported file is displayed on the window. 

 

 

7) Change the settings for the pasted items with the design window or data window. 
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5-11. Global change font 

5-11 
Global change font 

- Change the font of Multiple objects. 

 

- Global change font steps 

1) On the menu bar, select [View] > [Toolbar] > [Font] and [Face and alignment] 

- Font : [View]＞[Toolbar]＞[Font] checked. 

- Face and alignment : [View]＞[Toolbar]＞[Face and alignment] checked. 

 

 

2) Select the multiple objects that you want to change the font. 

The multiple objects can be selected by drug and drop, or Shift+Click. 

 

When multiple objects selected are assigned to multiple 

fonts, the font window will be blank.  

 

 

 

 

3) Multiple changes are reflected when you set [Font], [Height/Width] or [Alignment]. 

 

Font list shown on the Font window will be changed depending on the conditions of 

selected object.  

For example, in case of the object that can not be used Windows font is included, windows 

font can not be selected. 
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5-12. Create price including tax, base price 

5-12 
Create Tax-included price, Base price 

This chapter describes the creating method about tax-included price and base price. 

 

- Calculates the tax-included price from the base price. 

 

 

 

 

  

 

 

 

 

Place the price object. 
１ 

Click the [key input (data)] 2 

Check the [Use price calculation] 
3 

Select the [Tax included] 
4 

Click the [Close] button 
5 
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Place the price object. 
 

6 

Select the [Price1(Tax-included price)] 7 

Tax-included price entered by price1 field is printed.  

Sets "Not Printed" for the base price When 
only the [Tax-included] price is displayed. 
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- Calculates the base price (tax-excluded price) from the tax-included price.  

 

 

 

 

 

 

 

 

 

 

 

 

Place the price object. １ 

Click the [key input (data)] 2 

Check the [Use price calculation] 3 

Select the [Tax excluded] 
 

4 

Click the [Close] button 
 

5 
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Place the price object. 
 

6 

Select the [Pirce1(Tax-excluded price)] button 7 

Tax-excluded price entered by price1 field is printed.  
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- Change the rounding. 

Set how to round off decimals. This function rounds off the calculated tax price. Note that it 

does not either round off the tax-included price nor base price. 

 

Round down, round up, and round off all values below the specified digit. 

Round up (first decimal place) * rounds only the value with the first decimal place. 

*When using “Round up (First decimal place)” function, please check the version history and use SmaPri Driver 

version which is compatible with function. 

Warning: if using the SmaPri Driver version not compatible with the function, it will 

calculate by “Round off”. 

 

■ In the case of main unit price 576 yen, tax rate 8%, tax included calculation 

Rounding Consumption tax 

(after calculation) 

Consumption tax 

(after rounding) 

Tax included price 

Round down 46.08 \46 \622 

Round up 46.08 \47 \623 

Round up (First decimal place) 46.08 \46 \622 

Round off 46.08 \46 \622 

 

 

・Tax included 

 
The value that will be given by one of calculation transaction, Including TAX is “Tax Included 

price“ and “Consumption Tax”. 

 

If the input price value is "128" and the tax rate value is "10"(%). 

 128 × 0.10 = 12.8 (Consumption tax) 

If the rounding is selected “Round off” and the digits for dounding is selected “One decimal place”. 

 12.8 -> 13 (Consumption tax) 

Results of calculation… tax-included price is “141”, Consumption tax is “13”. 
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・Tax excluded 

 
The value that will be given by one of calculation transaction, excluding TAX is “Tax excluded price 

“ and “Consumption Tax”. 

 

If the input price value is "195" and the tax rate value is "10"(%) 

 195 / 1.10 = 177.272727 

 195 - 177.272727 = 17.727273 (Consumption tax) 

 

If the rounding is selected “Round up”and the digits for dounding is selected “One decimal palece” 

 17.727273 -> 18 (Consumption tax) 

 

Results of calculation… tax-excluded price is “177”, Consumption tax is “18”. 

 

  

[Notes] Discrepancy of the tax-excluded price 

Decimal points are rounded off when calculating the base price and tax price from the tax-

included price. Note that a discrepancy occurs between the original tax-included price and 

the tax-included price recalculated from the base price. 
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5-13. Tax rate seting 

5-13 
Tax rate setting 

Describes the setting method. 

 

The tax rate setting is each layout has. 

The setting method is different according to the layout type. 

Target Setting contents Setting items 

Existing 

layout 

Changes the tax rate for all layouts in a project. Tool > Convert > Global change of tax rate 

Changes the tax rate for individual layouts in a project. Layout settings > Tax and discount rates 

New 

layout 

Sets the tax rate when creating the new project. Tool > Settings > Tax rate tax rate 

Sets the tax rate when creating the new layout Layout default desettings > Tax and discount rates 

 

- Changes the tax rate for all layouts in a project. 

 

 

 

 

 

 

 

 

 

Click the [OK] button ４ 

 

Change the tax rate ３ 

 

Click the [Tool] １ 

 

 

Click the [Global change of tax rate] ２ 
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Click the [OK] button ５ 

 

 

Setting tax rate can be checked on price calculation dialog. 

Results of calculation was changed. 
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- Changes the tax rate for individual layouts in a project. 

 
 

 
 

 

Click the layout 
１ 

 

 

Click the [Tax and discount rates] 
３ 

 

 

Click the [Layout settings] 
２ 

 

 

Click the [Change rate] 
４ 

 

 

Change the tax rate 
５ 

 

 

Click the [OK] 
６ 
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Click the [OK] 

 

７ 

 

 

Results of calculation was changed. Setting tax rate can be checked on price 
calculation dialog. 
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- Sets the tax rate when creating the new project 

 

 

 

 

 

 

 

 

 

  

Click the [Tool] １ 

 

 

Click the [Settings] ２ 

 

 

Change the tax rate ３ 

 

 

Click the [OK] ４ 

 

 

Click the [×] and Exit the application. ５ 

 

 

After designing the new project, and then open the layout setting, revised tax rate is reflected. 
Please note that the existing tax rate of current project is not changed. 
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- Sets the tax rate when creating the new layout 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select the project 
１ 

 

 

Click the [Layout default settings] 
２ 

 

 

Click the [OK] 
３ 

 

 

Click the [Tax and descountrates] 
４ 

 

 
Click the [Change tax rat] 

５ 
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Change the tax rate 
６ 

 

 

Click the [OK] 
７ 

 

 

After designing the new project, and then open the layout setting, revised tax rate is reflected. 
Please note that the existing tax rate of current project is not changed. 

Click the [OK] 

 

８ 
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5-14. The paper rotation settings 

5-14 
The paper rotation settings 

This explains how to switch between and display the design screen sheet for 0, 90, 

180 and 270 degrees angles / views. 

 

Print label Design window 

 

 

 

 

- Rotate the paper 

 

 

 

Print 
direction 

Click the arrow button 

The direction of the arrow 
is print direction 

The paper rotate 90 degrees 
and basepoint is lower left. 



 
SmaPri Designer Operation Manual 

 

 

131 

 

 

 

- Displayed when rotating the sheet 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Click the string object １ 

 

Click designe area ２ 

 

If it has been rotated at any angl, It is 
set in the same direction as the 
screen. 

[0 degree] 

[90 degree] 

 

[270 degree] 

 

[180 degree] 

 

Ｘ 

Ｙ 

Ｘ 

Ｙ 

Ｙ 

Ｘ 

Ｙ 

Ｘ 

By pressing the arrow mark , the paper will rotate counter-clockwise. 
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5-15. Creating a barcode with variable length digits 

5-15 
Creating a barcode with variable length digits 

This section explains how to create a barcode with a variable number of digits. 

 

When the input method for CODE39 or QR code is set to "Key input (data)", data less than the 

number of digits will be filled in with half-width spaces. By preparing a separate string for data input, 

setting the barcode input method to "Reference / Concatenate" and the fill type to "Not fill", you can 

print a barcode with the number of digits without filling in with half-width spaces. 

 

[Settings] 

Paste the string for entering barcode data into the layout and enable "Not print". 

 

Example) Item name: Barcode, # of data: 20 Digits, Not print: Enabled 
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Next, paste a barcode onto the layout. Here we will use a QR code as an example. 

Set the QR code input method to "Reference / Concatenate", set the input string to Data, and set the 

fill type to "Not fill". 

 

Example) 

 

 

This completes the setup procedure. 

After creating a barcode, be sure to check that it can be read using test data. 
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5-16. Include line feed codes in QR code 

5-16 
Include line feed codes in QR code 

This section explains how to include a line feed codes in the QR code. 

 

When the barcode type is QR code, control codes can be included in the input data. 

This section explains how to include line break codes (CRLF) in QR code. There are two methods 

below. Control codes other than line break codes can also be included in the same way. 

 

- Use "Reference / Concatenate" 

Select "Binary" as the type of "Reference / Concatenate" and enter the control code in hexadecimal. 

The following is an example of including a line feed code between input data. 

 

 

 

- Include line break codes in input data for format print request 

Set input data including line break codes in the format print request to SmaPri Driver. 

Be sure to URL encode the input data (CRLF → %0D%0A) on the app side. 

 

Example of format print request) 

http://localhost:8080/Format/Print?__format_archive_url=http://xxxxx/test.spfmtz&__format_a

rchive_update=update&__format_id_number=1&QRCode=SATO%0D%0ATokyo%0D%0A0120

-XXXXXX&(Print quantity)=1 
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The 6th chapter: Appendix 

 

 

Appendix 

The 6th chapter 
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6-1. Glossary 

6-1 
Glossary 

This chapter describes the terms used in this operation manual. 

 

Project 

The management unit for data created with SmaPri Designer. The data created by SmaPri 

Designer is normally saved as a project file (extension ".spproz").  

Optionally, there is a method of saving files without archiving (compressing) them.  

In this situation, they are organized in a folder (folder extension ".files") with the same 

name as the project file (extension ".spproj"). When the project is saved with this method, 

please use the file and folder as a set when moving the files or backing up the project.  

Please note that when the name of the project file and folder that are not archived are 

changed, the software will no longer be able to reference the created data. 

 

Object 

The items pasted on the label including strings, barcodes, and other items.  

You can paste a maximum of 200 objects on 1 layout.  

For complicated editing such as when using Reference / Concatenate, you may not be able 

to paste 200 objects. Lines, frames, tables, and fixed graphic items are not counted. 

 

Record data 

The data for printing the label from the terminal issuing the print instruction.  

You can register 200 entries of record data in 1 project. 

 

Record No. 

The number for calling the label data with the terminal issues the print instruction.  

You can set this number from 1 to 9999. 

 

Print layout 

The data for specifying and printing the record No. from the terminal issuing the print 

instruction. 
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6-2. Error messages 

6-2 
Error messages 

Describes the error messages displayed during operation. 

 

Error messages Action 

There are characters included that 

can not be printed with this printer 

font. 

Change the font type. 

The characters that cannot be printed differ 

according to the type of font. 

The X1, 2, and 3 fonts can print single-byte 

alphanumeric characters and Japanese kana. The 

X70 to 77 fonts can print single-byte numbers \ , 

(comma) . (decimal point). The kanji font can print 

double-byte and single-byte alphanumeric 

characters and Japanese kana.  

The specified data is not registered in 

the table. 

The registration number that was input is not 

registered in the referenced table. 

The number of digits specified is 

smaller than the maximum number 

of digits for the table. 

The number of digits configured for the item 

referencing a table is set smaller than the number 

of digits for "Value" in the target table. Change 

"Value" for the table to the number of characters in 

the range of the digits or change the number of 

digits. 

An error occurred while generating an 

expand command. An error occurred 

when creating the layout item 

command. 

An error occurred during data output. 

Check that there are no objects displayed in red 

(error) on the print layout. 

You can check the error details by placing the 

mouse cursor on the object displayed in red. An error occurred while generating an 

expand command. 
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6-3. FAQ 

6-3 
FAQ 

This chapter contains frequently asked questions. 

 

- General 

1) Want to upgrade to the latest version of the software.  

- SmaPri Designer, SmaPri Driver 

Please download the latest version of the installer and the manuals on the support site. 

* You will be required to log in with the license ID and password in your support 

license. 

[SmaPri Support Site] 

http://dcs.sato.co.jp/SmaPri/support/index-en.asp 

 

- Printer driver (Use to test print on SmaPri Designer.) 

Download the Printer Driver installation software from your SATO local website. 

https://www.sato-global.com/drivers/redirect.html 

 

2) Want to know more information for other products than SmaPri. 

- Operator Manual and Quick Guide, for each printers. 

 

3) Other matters, technical support 

- Regarding SmaPri 

Please refer to the "Technical FAQ" on the support site. 

* You will be required to log in with the license ID and password in your support 

license. 

http://dcs.sato.co.jp/SmaPri/support/index-en.asp 

 

 

 

 

 

 

 

 

 

  

http://dcs.sato.co.jp/SmaPri/support/index-en.asp
https://www.sato-global.com/drivers/redirect.html
http://dcs.sato.co.jp/SmaPri/support/index-en.asp
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- SmaPri Designer 

1) Broke or Lost the USB key (HASP). 

Please contact the dealer where the product was purchased. 

 

2) A message appeared stating: "It works as an evaluation version. It can not use for 

commercial usage". 

・Are the power settings for your PC set to power saver? 

The USB key (HASP) operates by receiving power from the USB port. Power stops 

being supplied in power saver mode, and as a result, the USB key stops working. 

Please use the software with the power saver mode settings cleared. Also, when this 

occurs, the USB key can be recognized by the PC again by reinserting it. 

 

・Was the software installed as specified in this manual? 

If you insert the USB key (HASP) before installing the software, the USB key may no 

longer be recognized. Please install the software again with the USB key (HASP) 

unplugged from the PC. 

 

・Has the USB key (HASP) been firmly plugged all the way into the USB port on the PC? 

Firmly plug the USB key (HASP) into the USB port until you can no longer see the 

metal part. 

 

・Is the USB key (HASP) light on? 

If the light is off, or if the light is on but the USB key (HASP) is not recognized, please 

try to reinstall the device driver for the USB key (HASP). 

 

・Connecting to the PC via Remote Desktop? 

Due to restrictions on USB keys, it has been confirmed that license authentication 

fails when used via Remote Desktop. Please do not use Remote Desktop. 
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